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Nomad 3 Starter Project: Tool Organizer Tray 
This project will help you get familiar with your new Nomad 3 and walk you through the steps for creating 
a bamboo tool organizer tray. The tray fits 20 end mills in their plastic tool packaging, 15 loose end mills 
or other hardware, two ER collets, and an assortment of tools in the open pocket in the front of the tray. 

What You’ll Need 

• 6” × 7” × ½” bamboo plywood 

• #102 – 1/8” square end mill 

• Wasteboard 

• M6 × 10mm screws (x5) 

 

• 6mm hex key 

• 17mm collet wrench 

• 13mm spindle wrench 

• Double-sided tape  

Project Files  

All of the files used to create this project in Carbide Create and run it in Carbide Motion can be downloaded below. 
We’ve also included files to create and run this project using Fusion 360, if you would like to use that instead; 
however, the instructions in this guide only cover Carbide Create and Carbide Motion.  
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The zip file contains:    

• Bamboo Tray.svg — Saved design ready to create toolpaths in Carbide Create  
OR you may use this file to edit the tray design in a vector graphics editor (optional) 

• Bamboo Tray (Create).c2d  — Saved design and toolpaths in Carbide Create 

• Bamboo Tray (Create Gcode).nc — Saved G-code to run the job in Carbide Motion 

• Bamboo Tray (Fusion).f3d  — Saved design and toolpaths in Fusion 360 (optional) 

• Bamboo Tray (Fusion Gcode).nc — Saved G-code to run the job in Fusion 360 (optional) 

• Bamboo Tray Vectors.dxf —For editing the design in a vector graphics editor (optional) 

 

  
 

Required Programs 

Carbide Create 

This project was made with Carbide Create v5—if you haven’t downloaded the program yet or don’t have the latest 
version, head over to the download page and grab a copy. 

Carbide Create is a cross platform CAD/CAM program that is free to use and highly compatible with most CNC 
machines on the market.  

Get Carbide Create here 

Carbide Motion 

Carbide Motion lets you control your machine by jogging it around, setting zeroes, and loading and running G-code 
(the code that tells your machine when and how to mill). If you don’t have Carbide Motion yet, or you need the 
latest version, go ahead a download it now. 

Get Carbide Motion here 

Optional Programs 

Inkscape 

If you’d like to edit the tray design SVG, you are welcome to do so in a vector graphic program such as Inkscape or 
Adobe Illustrator. Inkscape is a free, open-source graphics editor for vector files. Use Inkscape to create and edit 
vector files that can then be used in Carbide Create. 

Get Inkscape here 

  

Download the Nomad3StarterProjectFiles.zip file here:
https://my.carbide3d.com/files/Nomad3StarterProjectFiles.zip

https://my.carbide3d.com/files/Nomad3StarterProjectFiles.zip
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Important Safety Notes 
The Nomad 3 has an interlock. When the spindle is running, opening the door will trigger the interlock and the 
spindle (and the job) will pause and move up to a parked position. When the interlock is triggered, Carbide Motion 
will display the pause screen. Once the door is closed again, you’ll need to click the Resume button on the pause 
screen to continue the job. 

The Nomad 3’s enclosure is there for two reasons: to contain the mess and to protect the user from broken cutters 
and flying stock.  

The end mills, or cutters, are made of carbide, a very hard, very brittle metal. When they break, they snap suddenly 
and without warning. The window will help protect you from any broken cutters. 

The second danger is that the stock material can break away during cutting. This can happen because you failed to 
use enough double-sided tape, because the material didn't adhere well enough using that tape, or because you 
were cutting too fast. 

If either of these happens during a job, power the machine down (hit the emergency-stop if one is available on your 
setup) and fix the problem.  

In summary, always close the cover when the machine is running. 

Download and Install Files and Programs 
1. Download and install Carbide Create and Carbide Motion. 

2. Download the project zip file (in Project Files above).  

3. Download Inkscape, if you would like to edit the tray design.  
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Set up the Project in Carbide Create 
1. Launch Carbide Create. 

2. In Carbide Create, go to File > Open and browse to where you saved the project files. 

3. Select the Bamboo Tray.svg file and click the Open button. 

4. When the file loads, you will see the design for our tool tray.  
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Designs can be created here in Carbide Create with the drawing and transform tools located in the Design tab. 
Or, designs can be created in a vector graphics editor, such as Inkscape, and imported into Carbide Create as an 
SVG file.  

5. Click the gear icon at the top-left of your screen to open the Job Setup window. Here you can see all of the 
parameters for the job, which were set when the design was originally created in Carbide Create: 

a. Stock Size is set to 6” x 7” to match our stock.  

b. Stock Thickness is ½” to match our stock.  

c. Zero Height is set to Top. 

d. Toolpath Zero (the origin or starting point of your project, marked on the canvas by a red and 
white circle) is set to Lower-Left.  

e. Material is set to Hardwood.  

f. Machine is set to Nomad 883. 

g. Retract Height (how high above the material the machine will retract during rapid moves. Set to a 
height which clears all clamping, if any) is set to 0.1000”. 

h. Units are set to Inch.  

6. If you want to cut this project using a different piece of wood than the bamboo plywood included in your 
kit, you’ll need to change the job settings. Otherwise, all of the parameters are correct, so go ahead and 
click Ok to close the Job Setup window.  
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Before we start creating toolpaths, we want to center the boundaries of the tray in the workspace, not butted up 
against any of the walls of our canvas. This will give us a little margin for error when machining our tray since the 
tray is slightly a narrower than our stock. 

7. Select all of the design features.  

Notice when a feature is selected, its outline becomes orange. 

8. Click the Group Vectors tool to group all of the features together.  
Notice as soon as you click the tool icon, that both the icon itself and the tool tip change from the “Group 
Vectors tool” to the “Ungroup Vectors tool”.  

PRO TIP:  To select multiple features (shapes/text/vectors in the design), click and drag around all of the features you 
want to select. If you need to add a feature or two to your bulk selection, hold the shift key while clicking on each new 
feature. 
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9. Click the Align Vectors tool. 

10. Click the Align Vertical and Horizontal Centers tool, which will center the design on the canvas. 

11. Click the Ungroup Vectors tool, to ungroup the features.   
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12. Click anywhere on the canvas to unselect the selected features. 
13. Now is a great time to save your file, in case you need to change something in the design later. Go to  

File > Save As, input a file name, such as My Bamboo Tray, and click Save. Carbide Create will save your file 
as a .c2d file.  

14. The design is now ready to go, unless you wanted to make any adjustments, such as changing the logo or 
adding text. 

  

NOTE:  .c2d is the format that Carbide Create uses to save design and toolpath information for future editing. Once we’re 
finished setting up our toolpaths, we’ll save the generated G-code as a .nc file. 



 

 

           support@carbide3d.com      docs.carbide3d.com      11/09/2020      v1 9 

A Quick Aside About Carbide Create Shortcuts 
As with any program, shortcuts can help you quickly and easily navigate Carbide Create. Here are a few to make 
your first project go smoothly. 

To adjust your  view of the canvas, go to View in the menu bar: 

• Reset View: Re-centers the canvas on the screen. 

• Snap to Grid: Forces all control points (nodes) to snap to the nearest grid point. This can be helpful 
when aligning features with the grid or each other. 

Mouse and Trackpad Shortcuts 

With a mouse or trackpad, you can zoom in/out and move the canvas around. You can also quickly select features. 

Mouse Trackpad 

Scroll wheel: Zoom in and out Drag with two fingers: Zoom in and out 

Right-click and drag: Pan/move the canvas Click and drag with two fingers: Pan/move the canvas 

Left-click:  Select a feature Click/tap with one finger: Select a feature 

Left-click + SHIFT: Select multiple features Click/tap with one finger + SHIFT: Select multiple features 

Left-click and drag: Create a selection box to select 
any feature that falls within the box boundary 

Click and drag with one finger: Create a selection box to 
select any feature that falls within the box boundary 

 

Keyboard Shortcuts 

With keyboard shortcuts, you can quickly and easily duplicate, select, and delete features and more. 

Windows Mac 

CTRL + S: Save file  |  SHIFT + CTRL + S: Save file as… CMD + S: Save current file  |  SHIFT + CMD + S: Save file as… 

CTRL + Z: Undo CMD + Z: Undo 

CTRL + X: Cut/delete selected feature(s) CMD + X: Cut/delete selected feature(s) 

CTRL + C: Duplicate selected feature(s) CMD + C: Duplicate selected feature(s) 

CTRL + A: Select all features CMD + A: Select all features 

SHIFT + Click: Select multiple features SHIFT + Click: Select multiple features 
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Set Up the Toolpaths 
Now we need to create the toolpaths that tell the Nomad 3 how to cut out our project. 

Quick Overview of Toolpaths 

When your CNC machine is running, it is executing G-code. G-code is created by defining toolpaths in Carbide 
Create. Think of toolpaths as your visual guide to “programming” your CNC machine. There are 4 basic types of 
toolpaths: 

• Inside Cut: Offsets the cutter to the inside of the feature 

• Outside Cut: Offsets the cutter to the outside of the feature 

• Pocket: Clears everything inside the feature 

• Engrave: Cuts directly on the line (no offset) 

We use the term offset to describe the toolpaths. In this case, offsetting means to move the cutting edge of the end 
mill to one side of the line or the other. 

Setting Up the Toolpaths 

First, we want to create a toolpath for all of the tray features, except the outer-most feature and the logo. All of 
these features will be pocketed to the same depth using an 1/8” end mill: 

1. Select all of the features except the logo and the perimeter rectangle. 

2. Click the Toolpaths button at the top of your screen to open the Toolpaths tab. 

NOTE:  The Bamboo Tray (Create).c2d file included in the project files is the completed design and toolpaths in Carbide 
Create, in case you want to reference, or work from, the competed design.   
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3. Click the Pocket button to create a pocketing toolpath. 
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4. In the Tool panel at the top of the screen, click the Edit button. 

5. The Edit Tool window is where you can change the cutting parameters and edit the selected cutting tool. 
Click the Select Tool button to choose a new end mill. 

a. Select Nomad and Hardwood from the dropdown lists at the top of the Select Tool window. 

b. Click End Mills to open the dropdown list, select #102 End Mill (1/8”), and click the Select button.  
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6. Change the Feed Rate to 75 and RPM to 22000, and click OK to save the new cutting parameters. 

7. We want the pockets cut down to a depth that is less than our material’s thickness—so anywhere between 
from 0.3 – 0.4 inches will work great. We have set our Max Dept (D) to 0.3750”. Keep in mind, deeper 
pockets will take marginally longer to machine.  

8. Name the toolpath “Primary Pocketing Toolpath”. Naming toolpaths helps remind us what each one does. 

9. Click the Ok button to save and close the toolpath settings. 
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10. You’ll see that our new Primary Pocketing Toolpath now appears in the Toolpath List, along with an 
approximate cutting time. 

11. We want to disable the toolpath temporarily so we can easily see what we’re working on when we create 
the next toolpath. Right-click on the toolpath name in the list and choose Disable. 
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Next, we want to create a pocketing toolpath for the Carbide 3D logo in the large tray pocket: 

1. Select the C-shaped profile and the surrounding hexagon. 

2. Click the Pocket button to create a pocketing toolpath.  

Selecting two different contours where one is inside the other and then adding a pocket toolpath to them 
will machine away the area between the two contours. 

  

NOTE:  Carbide Create selects the previously used tool by default, so there’s no need to change the tool for our final two 
toolpaths, since all three toolpaths use the 1/8” end mill. 
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3. We want to cut the logo pocket to 0.02” deeper than the large main pocket it’s within. So, we’ve set the 
Max Depth (D) to 0.3950”.  

4. We also need to change the Start Depth (S) to the depth of the main pocket, which is 0.375”.  

This lets Carbide Create know that it doesn’t need to worry about the material that was machined away 
previously. Note that these values are absolute, not relative. They don’t add up, so we’re not going to 
create a pocket that’s 0.77” deep and goes all the way through our stock with these settings. 

5. Name the toolpath “Logo Pocket”. 

6. Click Ok to save the toolpath. 
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Finally, to cut out our tray we need to select the tray outline and apply a contour toolpath on the outside of it: 

1. Select the perimeter feature and click the Contour button to create a contour toolpath.  
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2. We need to make sure that this toolpath will cut all the way through our stock, or ½” down. For the Max 
Depth (D) you can either input 0.5000” or click Use Stock Bottom.  

3. Set the Offset Direction to Outside/Right, name the toolpath “Contour Cutout”, and click Ok.  
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Previewing the Simulation 

Don’t forget we disabled the first toolpath so that it wouldn’t visually interfere with the creation of the last two 
toolpaths. To re-enable the toolpath: 

1. Right-click on the Primary Pocketing Toolpath and choose Enable.  
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Now we can preview a simulation of the final tool tray: 

1. Choose Pine from the material dropdown list. 

2. Uncheck Show Toolpath and Show Rapids and click the Show Simulation button.  

3. You can click and drag the simulation to angle the image for better viewing. If the simulation looks good, 
click the Save G-code button to export your G-code, .nc file, which we’ll load into Carbide Motion later. 

4. Press Ctrl+S (CMD+S on a Mac) to save your .c2d design file in case you need to make changes to it later.  
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Connect to the Nomad 3 
The Nomad 3 is controlled by Carbide Motion. To connect your machine to Carbide Motion: 

1. Power up your computer. 

2. Connect the USB cable to your computer and to the port on the outside of the Nomad 3 enclosure (at back-
right). 

3. Start Carbide Motion 5 on your computer. 

4. Power on your machine. 

5. In Carbide Motion, click the Connect to Cutter button.  
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Home the Nomad 3 
Now that you are connected to your machine, it’s time to home it. Homing your CNC machine is the process of 
sending it to a known, fixed, repeatable location. This means that every time you home the machine, it will move to 
EXACTLY the same position. Every. Single. Time. This allows you to move your machine to ANOTHER position, 
relative to the home position, with great precision. On your Nomad, the home is position is the back-right corner.  

To home the Nomad 3: 

1. Click the Initialize Machine button.  

During homing, the table will move to the front of the machine and the spindle will move to the back-right corner.   

PRO TIP:  Sometimes, later on in a project you will want to home the machine again. To do so, click MDI in the top menu 
bar to open the MID screen. Enter $H into the text field and click the Send button. This will re-home the machine. 
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Set Up Your Wasteboard  
Now, that the table is all the way to the front of the machine, it’s time to install the wasteboard. The wasteboard is 
used to protect the machine’s aluminum table from damage. While you can attach stock directly to the table, 
chances are that you’ll accidently cut through the stock material and into the table at some point, so we highly 
recommend using the wasteboard. To install the wasteboard: 

1. Place the wasteboard on the table with the countersunk holes facing up. 

2. Use a 6mm hex key and the five (5) M6 × 10mm screws to secure the wasteboard. 

Secure Your Stock  
Now, you need to secure your stock to the wasteboard. This process is called workholding. There are many 
different methods of workholding, including double-sided tape, clamps, direct fastening with nails or brads, low-
profile vise, and machinable wax. Which workholding solution you choose for each project will depend on several 
factors, including the type and size of your material and the kind of part you are milling.  

Since we’ll be using almost the entire surface area of our stock, there’s no room around the perimeter to hold the 
material down with clamps. Instead, we’ll be using double-sided tape, which is a simple, cheap way to temporarily 
secure your material.  

1. Cut a few strips of double-sided tape. We recommend using at least two strips long enough to span nearly 
the long edge of the material (approximately 5.5–6” long). We also added a third shorter strip of tape in 
the center to assure the stock doesn’t come loose. 

2. Place the two long strips of tape on the sides of the bamboo plywood, about one inch from the outside 
edge. Place the smaller strip in the middle.  

If you place the tape too close to the edge of the stock, you run the risk of your cutter getting all gunked up 
as it mills the outside edge of the tray.  
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3. Ensure there is no dust or dirt on the surface of the wasteboard that could weaken the tape adhesion. 

4. Align the bamboo to the wasteboard. Make sure the plywood is as close to parallel with the edges of the 
wasteboard as possible (don’t be afraid to draw a few marks or a line on the wasteboard if you need to). 

5. Apply firm pressure to the bamboo for several seconds to secure it to the wasteboard.  
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Install the End Mill 
After homing your Nomad 3, Carbide Motion will prompt you to load an end mill.  

The collet (1) holds the end mill (3) when the collet nut (2) is tightened in the spindle. Watch our End Mill 
Installation Tips video: https://www.youtube.com/watch?v=gOFUHPcKklE.   

NOTE:  A collet is sized to hold one diameter of cutter. Your Nomad 3 comes with a 1/8” ER-11 collet which is capable of 
holding any 1/8” cutter, even if you did not buy it from Carbide 3D. You can buy additional ER-11 collets to hold different 
diameter cutters from Carbide 3D or other vendors. 
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To install your end mill: 

1. Insert the shank of the end mill into the collet. 

2. Use the 17mm collet wrench to tighten the collet nut securely as you hold the spindle shaft in position with 
the 13mm spindle wrench.  

  

NOTE:  When tightening the collet nut, the tool should not extend more than 2 inches from the collet nut. 

WARNING:  Never tighten the collet nut without an end mill inserted into the collet. 
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3. Now that the end mill is installed, click the Resume button in Carbide Motion.  

4. Carbide Motion will position the cutter above the BitSetter, which will measure the end mill length. 

Set Job Zero 
Once your machine is homed, you can jog the machine (controlling the X, Y, Z axes movement of the machine) or 
load G-code.  

Before we load the G-code for our project, we need to tell the Nomad 3 where the origin point of the project is. If 
you remember from the Carbide Create section above, the origin point is in the lower-left corner of our stock. 

 

  

PRO TIP:  Carbide Motion uses millimeters by default. If you’re more comfortable working in inches, click Settings in the 
menu bar and choose “Inches” from the Units dropdown list. 
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To set job zero (the origin point), first we need to move the end mill so it’s centered over the corner of our stock: 

1. Click the Jog button in the menu bar. 

2. Use Carbide Motion to jog your machine to the lower-left corner of your stock: 

a. Use the Y- / Y+ buttons to position the Y-Axis 
(the table) and the X- / X+ buttons to position 
the X-Axis (the spindle, moving side-to-side). 

b. Use the Increment+ and Increment- buttons 
to speed up or slow down the machine’s 
movements. 

c. You may need to use the Z- / Z+ buttons to 
position your Z-Axis closer (the spindle, 
moving up/down) to the top of your stock so 
you can set X and Y more accurately. Make 
sure to always move slowly while 
approaching the top of your stock. Get the 
cutter close enough to determine your X/Y 
Zero without actually touching the top of the 
stock just yet. 

  

Jog Shortcut Keys 

Up Arrow: Move Y-Axis toward the back. 

Down Arrow: Move Y-Axis toward the front. 

Left Arrow: Move X-Axis to the right. 

Right Arrow: Move X-Axis to the left. 

, (Comma) : Move Z-Axis down. 

. (Period) : Move Z-Axis up. 

1,2,3,4 : Select Move Increment 
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3. Once the machine is in position over the lower-left corner, you’ll need to set job zero: 

a. Click the Set Zero button to bring up the Set Current Position screen. 

b. Click the Zero X button to set your X-axis to 0.00. You’re telling the controller that your machine is 
now where you want ZERO to be for the X. Do NOT click the Zero All button.  
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c. Click the Zero Y button to set your Y-axis to 0.00.  

d. Then, click Done to return to the Job screen. 

Set Z-Zero 
Now we need to set our Z-Axis starting point (Z-zero for short). The goal of setting Z-zero is to lower the cutter until 
it touches the very top of the material. Here is a video of the process: https://youtu.be/1FgMjg98cyM. 

Do NOT turn on the spindle yet! With your spindle in position over your stock material, your cutter installed 
(following the steps above), and with X-zero and Y-zero set (following the steps above), set Z-zero by: 

1. It’s easier to set Z-zero when the end mill is fully over the stock, so jog your machine a few millimeters 
inward from the corner (on both the X- and Y-Axes). 

2. Use the Z- button to begin lowering your cutter.  

3. As the cutter moves closer to the material, reduce your increment, by clicking the Increment– button, 
accordingly. You do NOT want to plunge the cutter directly into the material. We are trying to get the 
cutter to touch the very top of the material, but no further. 

4. Continue moving the cutter down until it is within about 1mm of the material.  
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5. Slide a small scrap of regular paper between the cutter and the material.  

6. Very slowly, and with a very small increment, resume lowering the cutter towards the material. 
Simultaneously, begin moving the paper back and forth across the top of the material.  

7. When the cutter grabs the paper and you can no longer wiggle it back and forth, stop lowering your cutter; 
you have found Z-zero. 
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8. In Carbide Motion, click the Set Zero button. 

9. Click the Zero Z button to set your Z-axis to 0.00. 

10. Click Done to return to the Jog screen. 
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11. In the Jog screen, use the Z+ button to raise the cutter to release the paper. 

Now your Nomad 3 knows exactly where to begin machining from. 

Load the G-code File 
The Nomad 3, as well as most other CNC machines, runs files called G-code. G-code is a format that goes back 
decades to the original CNC machines in the 1960s. G-Code is basically just a set of motion commands that tells a 
machine what cutter to use, a series of coordinates to move to, and the information about how fast to go. G-Code 
contains only this motion information, it does not contain your original CAD data anymore. 

1. Close the Nomad 3’s protective cover. 

2. In Carbide Motion, click the Run button in the menu bar to open the Run screen. 

3. Click the Load New File button. 

4. Browse for the Bamboo Tray (Create Gcode).nc file and click the Open button. 

  

NOTE:  Forgetting to set job zero (particularly Z-zero) is the number one cause of a project cutting in the wrong 
location. 
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5. Once the .nc file loads, you will see the approximate runtime, tools used, and other job info. 

6. Click the Start Job button.  

7. Then, click the Start button.  
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8. During the initial startup sequence, Carbide Motion will prompt you to make sure the correct tool is 
installed in the spindle. If it’s not, this is your last chance to correct that.  

9. Click the Resume button once you have confirmed that the correct tool is installed and milling will begin. 
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If all goes to plan, the Nomad will machine out all of the pockets and holes in the tray, and then trim up the outside 
of the bamboo. The program will take about 37 minutes to run. 

Finish Up the Project 
When the program is complete, the spindle will automatically stop, park, then home and the table will move all the 
way to the front of the machine so you can access the part. 

1. Pry the tray off the wasteboard. 

2. Remove the double-sided tape from the back of the bamboo. 

3. Since bamboo has a moderately coarse fiber structure, there will be some fuzz left along the walls of the 
tray. To clean things up, you can use some 220-grit sandpaper on the edges. 

NOTE:  If a lot of wood chips and dust are collecting on your workpiece, you can hit the Pause button in Carbide 
Motion at any time, open the door, and vacuum up the milling debris. 

PRO TIP:  If you peel the tape against the grain, some of the bamboo’s surface fibers could break free. If you want a 
smooth finish on the back of your tray, peel with the grain. 
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If everything went according to plan, you should have a functional tray to use. If something went wrong, and you 
need to try again (maybe your double-sided tape came loose), the included programs can be used on any ½” thick 
wood or plywood. 

If you’re not sure what went wrong, or found any of the steps in this tutorial confusing, don’t hesitate to reach out 
to our support team for help: support@carbide3d.com. 

 

  

PRO TIP:  If you intend to machine a lot of wood on your CNC, a downcutting end mill would be something we 
highly recommend. The reversed spiral of the downcutting end mill will push wood fibers down, rather than pull 
them up, which leaves a cleaner cut. The Amana 46200-K cutter found in our AMS-119 set would be a good drop-in 
replacement for the #102 end mill in this project. 



 

 

           support@carbide3d.com      docs.carbide3d.com      11/09/2020      v1 38 

 

Video Tutorial 
Watch the video tutorial for this project here: https://youtu.be/cD7HhA6mdEw. 

 

 


